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Adobe Photoshop 

 Основные приемы работы. Трансформация изображения.  

 

Задание 1. Изменение размера изображения. 

1. Откройте изображение ps_Практика-1\Размеры\Раковины.jpg. Возьмите 

инструмент Zoom(Масштаб), на панели свойств инструмента нажмите кнопку 

Actual Pixels(Фактический размер). Данное изображение имеет большой размер 

и хорошее качество. Уменьшите изображение: меню Image(Изображение) → 

Image Size(Размер изображения). Как видите, ширина изображения 1024 

пикселя, а высота 683 пикселя, разрешение 120 пикселей на дюйм. Введите в 

поле Width(Ширина) значение 600. Обратите внимание, что значение в поле 

Height (Высота) автоматически изменилось и пропорции не нарушились, 

благодаря тому, что стоит флажок Constraint Proportions (Сохранять 

пропорции). Нажмите ОК. Изображение стало меньше и его качество немного 

ухудшилось, фотография стала «замыленной». Сохраните уменьшенное 

изображение в свою рабочую папку: меню File(Файл) → Save as… (Сохранить 

как…). 

2. Откройте изображение ps_Практика-1\Размеры\Фотоаппарат.jpg. 

Посмотрите размер изображения: меню Image(Изображение) → Image 

Size(Размер изображения). Как видите, ширина изображения 300 пикселя, а 

высота 242 пикселя, но разрешение 300 пикселей на дюйм. Благодаря высокому 

разрешению, несмотря на маленький размер, изображение хорошего качества. 

Увеличьте размер изображения, для этого введите в поле Width(Ширина) новое 

значение, например, 800, нажмите ОК. Обратите внимание, как ухудшилось 

качество фотографии! Закройте изображение без сохранения. 

Вывод: любое изменение размера, ухудшает качество изображения. Особенно 

это заметно при увеличении размера. 

 

Задание 2. Кадрирование изображения. 

Прочитайте как работать с инструментом Crop(Кадрировать) в разделе 

«Практическая часть» (см. ps_Теория-1.doc), пункты «Кадрирование 



изображения с помощью рамки» и «Указание размеров и разрешения при 

обрезке изображения». 

1. Откройте исходное изображение ps_Практика-1\Обрезка\Школа.jpg. 

Обрежьте изображение так, чтобы кадр стал более выраженным. Чтобы этого 

добиться можно пожертвовать столбом,  частью дорожки, и, возможно 

затемненной частью слева на фотографии. Стремитесь к тому, чтобы подъезд 

оказался ближе к центру изображения. Сохраните результат в свою рабочую 

папку под новым именем.  

2. Откройте исходное изображение ps_Практика-1\Обрезка\Доспехи.jpg. Ваша 

задача, сохранить каждый шлем в отдельном файле. Для работы используйте 

инструмент Crop(Кадрировать). После операции кадрирования и сохранения 

шлема в новом файле, отменяйте все выполненные команды с помощью палитры 

History(История), чтобы вернуться к исходному изображению.  

3. Откройте три фотографии Кошка1.JPG, Кошка2.JPG и Кошка3.JPG из 

ps_Практика-1\Обрезка.Обрежьте все три фотографии с одновременной 

подгонкой размера, так чтобы получилось три изображения одного размера 

600500 пикселей. При обрезке следите за тем, чтобы кошка оказывалась в 

центре кадра. Сохраните новые фотографии в свою рабочую папку под новыми 

именами.  

 

Задание 3. Поворот изображения. 

1. Откройте исходное изображение ps_Практика-1\Поворот\Дания.bmp.  

2. Активизируйте инструмент Measure(Измерение), который находится в 

группе инструментов Eyedropper(Пипетка). Проведите линию вдоль горизонта, 

а так как горизонт «завален», то линия получится наклонная.  

3. Войдите в меню Image(Изображение) → Rotate Canvas(Поворот холста) → 

Arbitrary (Произвольно). Вы увидите угол, на который нужно повернуть 

фотографию, чтобы изображение выровнялось. Имейте в виду, что этот угол вы 

задали сами, когда проводили линию инструментом Measure(Измерение), 

поэтому возможно, что результат будет не совсем удовлетворительным. 



Нажмите ОК. Если горизонт все еще «завален», отмените действие (нажмите 

клавиши Ctrl+Z) и проделайте все действия заново.  

4. После поворота изображения проведите его кадрирование инструментом 

Crop(Кадрировать).  

5. Получив хороший результат, сохраните изображение в свою рабочую папку 

под новым именем. 

6. Таким же образом исправьте фотографии Москва.jpg и Лужники.jpg. 

 

Задание 4. Свободная трансформация объекта. 

1. Откройте исходное изображение ps_Практика-1\Transform.psd.  

2. Включите линейки: View (Вид) → Rulers(Линейки). Установите единицы 

измерения на линейках –  пиксели. 

3. Увеличение холста. Используя инструмент Crop (Кадрирование), увеличьте 

размер холста на 100px. При изменении размера холста ориентируйтесь по 

линейкам. 

4. Перейдите на слой Фон. Используя инструмент Pain Bucket(Ведро краски), 

закрасьте новую часть фона синим цветом. 

5. Создайте 3 копии слоя Телефон-1, назовите новые слои, соответственно, 

Телефон-2, Телефон-3, Телефон-4. Перейдите на слой Телефон-1. Отключите 

видимость остальных слоев. 

6. Режим свободной трансформации. Возьмите инструмент Move(Движение). 

Включите режим свободной трансформации: Edit(Редактирование) → Free 

transform (Свободная трансформация) или нажав клавиши Ctrl+T. 

7. Трансформация. Удерживая клавишу Shift, уменьшите размер телефона. 

Переместите телефон в левый верхний угол. Поверните телефон на небольшой 

угол. Закончите трансформацию, нажав клавишу Enter. 



8. Зеркальное отражение. Перейдите на слой Телефон-2. Уменьшите размер 

изображения. Выполните зеркальный поворот по вертикали: 

Edit(Редактирование) → Transform (Трансформация) → Flip Vertical (Отразить 

вертикально). Выполните зеркальный поворот по горизонтали: 

Edit(Редактирование) → Transform (Трансформация) → Flip Horizontal 

(Отразить горизонтально). Переместите телефон в нижний правый угол. 

9. Изменение размера в процентах. Перейдите на слой Телефон-3. Выберите 

инструмент Move(Движение). Перейдите в режим свободной трансформации и 

на панели свойств инструмента Move(Движение) задайте размеры изображения – 

80% по ширине и по высоте.  

10. Перспектива. Измените перспективу изображения: Edit(Редактирование) 

→ Transform (Трансформация) → Perspective (Перспектива). Переместите 

телефон в правый верхний угол.  

11. Выравнивание и распределение. Перейдите на слой Телефон-4. Уменьшите 

размер изображения на 30%. Скопируйте слой еще два раза. Размести маленькие 

телефона на разном расстоянии друг от друга. Сцепите слой Телефон-4 и две его 

копии. Перейдите в режим свободной трансформации. Используя панель свойств 

инструмента Move(Движение), выровняйте телефоны по левому краю и 

распределите между собой на одинаковом расстоянии (команды Alignи 

Distribute). 

12. Сохраните результат трансформации в новом файле на своем рабочем диске. 

 

Задание 5. Освоение основных приемов работы. 

Освойте основные приемы работы в Photoshop. Готовую работу можно 

посмотреть в ps_Практика-1\Московский_Кремль.jpg. 

1.Создание нового рисунка. Пуск → Программы → Photoshop. Создайте 

новый рисунок по размеру печатной страницы 21 см х 29,7 см: File (Файл) → 

New (Новый). В поле Name (Имя) задайте имя рисунка: Московский_Кремль. В 

поле Width (Ширина) напечатайте 21. В поле Height (Высота) напечатайте 29,7. 

Проверьте, чтобы напротив этих полей были установлены единицы измерения 

см, т.е. сантиметры. В поле Resolution (Разрешение) можно оставить стандартное 



предложение 72 пикселя на дюйм. В поле Mode (Режим) должно стоять RGB 

Color (Цвет RGB). Из списка Background contents (Содержимое фона) выберите 

White (Белый). Нажмите кнопку ОК. 

2.Линейка. Включите измерительную линейку: View (Вид) → Rulers 

(Линейки). Если на линейке единицы измерения в сантиметрах, переведите их в 

пиксели, т.к. при работе на мониторе удобнее пользоваться его «родными» 

единицами измерения: Edit (Редактирование) → Preferences (Настройки) → 

Units&Rulers (Единицы и Линейки) →  в списке Rulers (Линейки) выберите 

Pixels (Пиксели) → ОК. 

3.Направляющие. Установите направляющие линии, которые помогут вам 

точно выровнять текст и фотографию на странице. На панели инструментов 

выберите инструмент Move (Движение). Укажите белой стрелкой мыши на 

верхнюю горизонтальную линейку, нажмите левую кнопку мыши и протащите 

мышь вниз. За мышью потянется тонкая синяя горизонтальная линия, это и есть 

горизонтальная направляющая. Смотрите на вертикальную линейку, когда 

направляющая окажется на делении 150, отпустите мышь. Здесь будет верхний 

край фотографии. Если линия не точно стоит на делении 150, укажите на нее 

мышкой и вы увидите указатель в виде узкой черной вертикальной стрелочки. 

Нажмите левую кнопку мыши и протащите направляющую в нужное место. 

Также установите вторую горизонтальную направляющую на делении 600. Здесь 

будет верхняя строка текста. Из вертикальной линейки слева вытащите 

вертикальную направляющую и установите ее на делении 550 верхней линейки. 

Здесь будет крайняя правая граница фотографии и текста. 

4. Привязка к направляющим. Посмотрите, чтобы в меню View (Вид) в списке 

Snap to (Привязать к...) стоял флажок напротив Guides (Направляющие). 

Рекомендуется убрать привязку к границам документа: View (Вид) → Snap to 

(Привязать к...) → снять флажок с команды Document Bounds (Границы 

документа). 

5. Открытие фотографии. Откройте фотографию: File (Файл) → Open 

(Открыть) → ps_Практика-1\Кремль.jpg. 

6. Изменение размера изображения Посмотрите на горизонтальную линейку 

рисунка Кремль, ширина этого изображения 600 пикселей, поэтому ширина 

фотографии Москва не должна быть больше 500 пикселей (учитывая, что нужно 

оставить поля на странице)..Image (Рисунок) → Image Size (Размер рисунка) → в 



поле Width (Ширина) установите 500 пикселей → ОК. Обратите внимание, что 

значение в поле Height(Высота) изменилось автоматически (стало 304).  

7. Вставка изображения в другой рисунок. Теперь фотографию нужно 

переместить в рисунок Кремль. Подвиньте окно с фотографией так, чтобы видеть 

часть окна рисунка Кремль. Возьмите инструмент Move (Движение), укажите на 

фотографию, нажмите левую кнопку мыши и перетащите фотографию в окно 

рисунка Кремль, отпустите мышь. Фотография оказалась на отдельном слое с 

именем Layer 1 (Слой 1) над фоновым слоем Background (Фон). Переименуйте 

слой Layer 1 в Фото, для этого на палитре Layers (Слои) дважды щелкните по 

названию слоя Layer 1 и введите название Фото. Закройте окно с фотографией 

Москва, на вопрос о сохранении изменений нажмите кнопку No (Нет). 

8. Размещение фотографии по направляющим. Активизируйте слой с 

фотографией Фото и инструментом Move (Движение) подвиньте фотографию 

так, чтобы ее верхний край оказался на горизонтальной направляющей 150 

пикселей, а правый край на вертикальной направляющей 550 пикселей. Обратите 

внимание, что фотография «прилипает» к направляющим линиям. 

9. Ввод текста. Создайте новый слой, над слоем Фото. Инструментом Type 

(Печатать) щелкните в любом месте слоя. На панели свойств текста выберите 

шрифт Arial Black, размер 30pt (пунктов), выравнивание По правому краю и 

черный цвет. Напечатайте на двух строчках фразу МосковскийКремль.  

10. Перемещение текста. Инструментом Move (Движение) передвиньте текст 

под фотографию и установите по направляющим.  

12. Изменение цвета текста. Инструментом Type (Печатать) выделите букву 

М, в палитре Swatches(Плашки) щелкните по окошку с оранжевым цветом. 

Также перекрасьте в оранжевый цвет букву К. Можно при этом увеличить 

размер шрифта этих букв, например на 36pt 

13. Создание цветной полосы. В палитре Layers(Слои) щелкните по слою 

Background(Фон) и нажмите кнопку Create a new layer(Создать новый слой). 

Обратите внимание, новый слой всегда создается над рабочим 

активизированным слоем. Назовите новый слой Полоса. На панели 

инструментов выберите инструмент Rectangular Marquee(Прямоугольное 

выделение). Сделайте прямоугольное выделение слева по всей высоте рисунка 

шириной 200 пикселей. Возьмите инструмент Paint Bucket (Заливка), в палитре 



Swathes(Плашки) выберите синий цвет и щелкните в выделенной области. 

Снимите выделение: меню Select(Выделение) → Deselect (Снять выделение). 

Также создайте новый слой выше слоя Полоса, назовите его Подложка, 

нарисуйте прямоугольное выделение так чтобы оно было больше фотографии на 

слое Фото. Выберите голубой цвет и возьмите инструмент Gradient (Градиент), 

на панели свойств инструмента из списка стандартных градиентов выберите 

Foreground to Transparent(Сплошной в прозрачный) и мышью протяните вдоль 

выделенной области. У вас должен получиться полупрозрачная градиентная 

заливка. Снимите выделение, нажав Ctrl+D (клавиатура должна быть в 

английской раскладке).  

14. Сохранение рисунка в двух форматах: PSD и JPEG.  

Для редактирования (формат PSD): File (Файл) → Save (Сохранить). В поле 

Папка выберите свой рабочий диск. В поле Имя файла уже стоит имя 

Московский_Кремль. В поле Format (Формат) должно стоять Photoshop(*.PSD, 

*.PDD). Нажмите кнопку Сохранить. 

Для Web-сайта (формат JPEG): File (Файл) → Save for Web (Сохранить для 

Web). В окне сохранения выберите формат JPEG высшего качества High. 

Нажмите кнопкуSave (Сохранить). В поле Папка выберите свой рабочий диск. В 

поле Имя файла уже стоит Московский_Кремль. В поле Тип файла должно 

стоять Images Only (*.jpg). Нажмите кнопку Сохранить. 

 

 Основные приемы работы. Работа с многослойным изображением.  

 

Задание 1. Выделение областей изображения разными способами. 

1. Создайте новый рисунок с именем Select, размером 800600 пикселей, фон 

– черный. Откройте файл  ps_Практика-2\Выделение\1_Rectangular_Marquee.jpg. 

Используя инструмент Rectangular_Marquee (Прямоугольное выделение), 

выделите центральную часть изображения. Скопируйте выделенную область в 

рисунок Select, для этого в окне с фотографией нажмите сочетание клавиш 

Ctrl+C, перейдите в окно рисунка Select и нажмите сочетание клавиш Ctrl+V. 

Закройте окно с фотографией. 

2. Откройте файл ps_Практика-2\Выделение\2_Eleptical_Marquee.jpg. 

Используя инструмент Eleptical_Marquee (Эллиптическое выделение) и 

команду трансформации выделения Transform Selection (из меню Select), 



выделите одну клубнику. Скопируйте выделенную область в рисунок Select. 

Закройте окно с фотографией. 

3. Откройте файл  ps_Практика-2\Выделение\3_Magic_Wand.jpg. Используя 

инструмент Magic_Wand (Волшебная палочка) в режиме добавления к 

выделенному (Add to selection), выделите фон вокруг фламинго. Инвертируйте 

выделение: меню Select (Выделить) → Inverse (Инвертировать). Скопируйте 

выделенную область в рисунок Select. Закройте окно с фотографией без 

сохранения. 

4. Откройте файл  ps_Практика-2\Выделение\4_Lasso.jpg. Используя 

инструмент Lasso (Лассо) с растушевкой (Feather) 5px, сделайте произвольное 

выделение. Скопируйте выделенную область в рисунок Select. Закройте окно с 

фотографией. 

5. Откройте файл  ps_Практика-2\Выделение\5_Poligonal_Lasso.jpg. Используя 

инструмент Poligonal_Lasso (Многоугольное лассо), выделите грузовик. 

Скопируйте выделенную область в рисунок Select. Закройте окно с фотографией. 

6. Откройте файл  ps_Практика-2\Выделение\6_Magnetic_Lasso.jpg. Используя 

инструмент Magnetic_Lasso (Магнитное лассо), выделите мотоциклиста. 

Скопируйте выделенную область в рисунок Select. Закройте окно с фотографией. 

7. Откройте файл  ps_Практика-2\Выделение\7_Type_Mask.jpg. Используя 

инструмент Horizontal_Type_Mask (Горизонтальная текстовая маска), 

напечатайте слово КОСМОС в центре фотографии, используйте широкий 

шрифт, например, Arial Black и крупный размер шрифта – 140 пунктов. 

Скопируйте выделенную область в рисунок Select. Закройте окно с фотографией 

без сохранения. 

8. Откройте файл  ps_Практика-2\Выделение\8_Quick_Mask.jpg. Используя 

режим Quick_Mask (Быстрая маска), выделите полосатую кошку, для этого 

гладкой кисточкой закрасьте кошку по контуру, залейте середину сплошной 

заливкой, вернитесь в обычный режим и выверните выделение, нажав 

Shift+Ctrl+I. Скопируйте выделенную область в рисунок Select. Закройте окно с 

фотографией без сохранения. 

 

Задание 2. Освоение инструментов Brush, Paint Bucket. Использование 

эффектов (стилей) слоя. 

Готовую работу можно посмотреть вps_Практика-2\Animals.jpg 

1. Создание нового рисунка. Меню File (Файл) → New (Новый). В поле Name 

(Имя) напишите Animals. В поле Width (Ширина) поставьте 550pixels 

(пикселей). В поле Height (Высота) поставьте 350pixels (пикселей). В поле Mode 



(Режим) должен стоять режим RGB Color (Цвета RGB). В разделе Contents 

(Содержимое) отметьте White (Белый фон). Нажмите ОК. Немного увеличьте 

размер окна рисунка, чтобы видеть границы рисунка.  

2. Направляющие линии. Направляющие линии помогают размещать объекты 

на одной линии, и рисовать прямоугольные и круглые объекты одного размера. 

Включите линейки: View (Вид) →Rulers (Линейки). Возьмите инструмент Move 

(Перемещение)  . Вытаскивая с линеек направляющие линии, сделайте 

разметку плаката. Включите привязку объектов к направляющим линиям: меню 

View (Вид) → Snap To (Привязать к...) – должна стоять точка напротив Guides 

(Направляющие). Совет: отключите привязку к границам документа, для этого в 

меню View (Вид) → Snap To (Привязать к...) – уберите галочку напротив 

Document Bounds (Границы документа).  

3. Создание узорной заливки. В меню File (Файл) → Open (Открыть) откройте 

файл 

ps_Практика-2\трава.jpg. Войдите в меню Edit (Редактирование) выберите 

команду Define Pattern (Определение узора). Появится окно, в поле Name (Имя) 

напишите название узора – Трава. Нажмите ОК. Закройте файл трава.jpg. 

4. Применение узорной заливки. В рисунке Animals создайте новый слой 

(Рис.1), дважды щелкните по его названию Layer 1, переименуйте в Трава. 

Возьмите инструмент Paint Bucket (Ведро краски)  на панели свойств (см. 

вверху) в списке Fill (Заливка) выберите Pattern (Узор), напротив появится 

список узоров, выберите узор Трава, он будет в конце списка. Щелкните один 

раз по фону рисунка Animals.  

Рис. 1. Кнопка для создания нового слоя. 

 

5. Полупрозрачный слой. Создайте новый слой над слоем Трава, назовите его 

Прозрачный. Возьмите инструмент Paint Bucket (Ведро краски) на панели 

свойств (см. вверху) в поле Fill (Заливка) выберите команду Foreground 

(Передний план). В палитре цветов Swatches (Образцы цветов) выберите синий 

цвет, щелкните по рисунку. В палитре Layers (Слои) в поле Opacity 

(Непрозрачность) установите 80%.  



6. Вставка рисунка в формате GIF. Откройте файл ps_Практика-

2\лошадь.gif.Немного увеличьте размер окна рисунка, чтобы видеть его границы. 

Возьмите инструмент Rectangular Marquee (Прямоугольное выделение) . 

Нарисуйте рамку выделения вокруг всего рисунка. возьмите инструмент Move 

(Движение) . Перетащите рисунок лошади на плакат Animals. Закройте файл 

лошадь.gif без сохранения изменений.  

7. Изменение размера. Должен быть активен инструмент Move (Движение). В 

меню Edit (Редактирование) включите команду FreeTransform (Свободная 

трансформация). Чтобы сохранить пропорции, нажмите клавишу Shift, и 

уменьшайте рисунок лошади. Чтобы зафиксировать изменения, нажмите 

клавишу Enter.  

8. Зеркальный поворот. Чтобы повернуть лошадь, зайдите в меню Edit 

(Редактирование) → Transform (Трансформация) → Flip Horizontal 

(Горизонтальный поворот).  

9. Очищение рисунка от фона. Чтобы удалить белый фон, возьмите 

инструмент Magic Wand (Волшебная палочка)  . На панели свойств в поле 

Tolerance (Сглаживание) поставьте небольшое значение 5-10 пикселей и 

нажмите Enter. Чем меньше это значение, тем более гладкие края будут у 

рисунка после очищения фона. Щелкните по белому фону и нажмите клавишу 

Delete. Снимите пунктирное выделение: меню Select (Выделение) → Deselect 

(Снять выделение). У цветка остался белый фон! Увеличьте масштаб рисунка 

инструментом Zoom (Масштаб) . Удалите фон инструментом Magic Wand 

(Волшебная палочка), снимите выделение. Чтобы уменьшить масштаб рисунка: 

на панели свойств нажмите кнопку Actual Pixels (Фактический размер) или 

кнопку Fit on Screen (Подходящий к экрану). Таким же способом вставьте 

рисунки козы и обезьяны, очистите их от белого фона, и разместите рядом с 

рисунком лошади. Переименуйте слои с рисунками дайте им соответственно 

имена Лошадь, Коза и Обезьяна. 

10. Рисование прямоугольников. Над слоем Прозрачный создайте новый слой, 

назовите его Таблички. Возьмите инструмент Rectangular Marquee 

(Прямоугольное выделение)  . На панели свойств (см. вверху) нажмите кнопку 

Add To Selection (Добавлять к выделенному) . На палитре Swatches (Образцы 

цветов) выберите зеленый цвет. Нарисуйте прямоугольные таблички под 

лошадью, обезьяной и козой. Возьмите инструмент Paint Bucket (Ведро краски)

и щелкните в любой табличке. Снимите выделение: меню Select (Выделение) 

→ Deselect (Снять выделение).  



11. Эффекты (стили) слоя. На палитре Layers (Слои) нажмите кнопку Add a 

Layer Style (Добавить стиль слоя) (Рис. 2). Появляется список стилей 

(эффектов): 

1. Blending Options – смешивание вариантов 

2. Drop Shadow – падающая тень 

3. Inner Shadow – внутренняя тень 

4. Outer Glow – внешнее свечение 

5. Inner Glow – внутреннее свечение  

6. Bevel and Emboss – скос и рельеф (объемность) 

7. Satin – шелк (эффект металлической поверхности) 

8. Color Overlay – цветовой оверлей (наложение цвета) 

9. Gradient Overlay – градиентный оверлей (наложение градиента) 

10. Pattern Overlay – узорный оверлей (наложение узора) 

11. Stroke – контур (обводка по границе рисунка) 

Рис. 2. Кнопка для добавления эффектов (стилей) слоя. 

 

Выберите стиль Bevel and Emboss (Скос и рельеф), установите следующие 

параметры: Style (Стиль) = Emboss (Рельеф), Size (Размер) = 18px. В эффекте 

Contour (Контур) (Рис. 3) выберите Rounded Steps (Скругленные ступени)   . 

Нажмите ОК. 

Рис. 3. Эффект Contour (Контур) в списке эффектов слоя. 

 

12. Сохранение стиля слоя. Щелчком выделите слой Лошадь. Из списка 

стилей (эффектов) выберите Drop Shadow (Падающая тень), а потом Outer Glow 

(Внешнее свечение). Увеличьте внешнее свечение: Size (Размер) = 18 px. 

Выберите контур внешнего свечения Cone Inverted (Перевернутый конус) . 

Нажмите ОК. Сохраните эти  эффекты как стиль Нимб: откройте палитру Styles 

(Стили), нажмите кнопку Create New Style (Создать новый стиль) (Рис. 4), в 

поле Name (Имя) напишите Нимб, нажмите ОК.  В конце списка стилей этой 



палитры появилась новая кнопка Нимб. Выделите слой Обезьяна, щелкните по 

кнопке стиля Нимб. Выделите слой Коза, щелкните по кнопке стиля Нимб. 

Рис. 4. Кнопка для добавления нового стиля в список существующих стилей. 

 

13. Фильтр Ripple (Рябь). Создайте новый слой над слоем Коза, назовите его 

Полоски. Инструментом Прямоугольное выделение нарисуйте две полоски 

вверху и внизу плаката, залейте голубым цветом и задайте этому слою Opacity 

(Непрозрачность) 50%. Снимите выделение: Ctrl+D. Зайдите в меню Filter 

(Фильтр) → Distort (Исказить) → Ripple (Рябь). В списке Size (Размер) выберите 

Large (Большой), нажмите ОК.  

14. Эффект кнопки. Создайте новый слой над слоем Полоски, назовите его 

Кнопка. Инструментом Прямоугольное выделение нарисуйте прямоугольник, 

залейте голубым цветом, задайте непрозрачность 80%. Примените эффект слоя 

Bevel and Emboss (Скос и рельеф): Style (Стиль) = Inner Bevel (Внутренний 

скос), Size (Размер) = 21px. В свойстве Contour (Контур) выберите Half 

Round (Полукруг). Нажмите ОК. 

15. Создание стиля для текста. Создайте новый слой над слоем Кнопка. 

Возьмите инструмент Horizontal Type (Печатать горизонтально)  . На панели 

свойств установите шрифт Arial Black, размер 60pt (пунктов), цвет – белый. 

Напечатайте на кнопке слово ANIMALS. На панели свойств нажмите кнопку 

Create Warped Text (Создать оболочку текста)  , из списка Style (Стиль) 

выберите Fisheye (Рыбий глаз), нажмите ОК. Возьмите инструмент Move 

(Движение)  , включите свободную трансформацию: Ctrl+T (клавиатура 

должна быть в английской раскладке) и растяните надпись на всю кнопку, 

нажмите Enter. Примените эффект Drop Shadow (Падающая тень). 

16. Фильтр Spherize (Сферичность). Создайте новый слой под слоем 

ANIMALS, назовите его Блик. Возьмите инструмент Brush (Кисть)  . На 

панели свойств из списка Brush (Кисть) выберите размытую кисть диаметром 65 

пикселей. В палитре цветов Swatches (Образцы цветов) выберите желтый цвет. 

Несколько раз мазните под надписью. Зайдите в меню Filter (Фильтр) → Distort 

(Исказить) → Spherize (Сферичность), нажмите ОК. 



17. Создание кисти. Создайте новый рисунок размером 50 на 50 пикселей, фон 

– Transparent (Прозрачный). Используя инструмент Brush (Кисть) , черным 

цветом нарисуйте листик дерева. Белым цветом нарисуйте прожилки на листе. 

Можно добавить эффект Gradient Overlay (Градиентное наложение цвета), 

цвета оставьте черный и белый.  Установите в этом эффекте Opacity 

(Непрозрачность) = 90%.  

Внесите этот листик в список кистей: меню Edit (Редактирование) → Define 

Brush (Определение кисти), в поле Name (Имя) напишите Лист, нажмите ОК. 

Закройте рисунок с листиком без сохранения. В рисунке Animals на панели 

свойств из списка Brush (Кисть) выберите кисть Лист (см. в конце списка). 

Выбирая разные цвета в палитре цветов Swatches (Образцы цветов), поставьте на 

слое Блик несколько цветных листьев.  

18. Сохранение рисунка в двух форматах: PSD и JPEG. 

Для редактирования (формат PSD): File (Файл) → Save (Сохранить). В поле 

Папка выберите свой рабочий диск. В поле Имя файла должно стоять Animals.  

В поле Format (Формат) должно стоять Photoshop(*.PSD, *.PDD). Нажмите 

кнопку Сохранить. 

Для Web-сайта (формат JPEG): File (Файл) → Save for Web (Сохранить для 

Web). В окне сохранения выберите формат JPEG высшего качества High. 

Нажмите кнопку Save (Сохранить). В поле Папка выберите свой рабочий диск. 

В поле Имя файла должно стоять Animals. В поле Тип файла должно стоять 

Images Only (*.jpg). Нажмите кнопку Сохранить. 

 

Задание 3. Слияние фотографий 

Пример использования этого эффекта можно посмотреть вps_Контрольная-

1\Вариант-3\_Вариант-3.jpg 

1. Создайте новый рисунок (File → New). 

2. Откройте две фотографии и перетащите их в новый рисунок. Фотографии 

разместятся на отдельных слоях. Передвиньте фотографии на слоях так, чтобы 

они немного перекрывали друг друга. Активизируйте верхний слой с 

фотографией (щелкните по слою, чтобы имя слоя подсветилось темно-серым 

цветом).   

3. Перейдите в режим быстрой маски, нажав кнопку Edit in Quick Mask Mode 

(Редактирование в режиме быстрой маски) (Рис. 5). 

 



Рис. 5. Кнопка для перехода в режим быстрой маски. 

 

4. Нажмите клавишу D, чтобы установить стандартную настройку цвета: цвет 

инструмента – черный, цвет фона – белый. Возьмите инструмент Gradient 

(Градиент), на панели свойств инструмента выберите черно-белый линейный 

градиент, также проверьте, чтобы стояли стандартные настройки Mode (Режим) 

и Opacity (Непрозрачность) (Рис. 6). 

 
Рис. 6. Настройки инструмента Gradient (Градиента). 

 

5. Проведите вектор градиента (нажмите левую кнопку мыши там, где должна 

быть видимая часть фотографии, протащите указатель мыши в ту сторону, где 

будет невидимая часть фотографии, отпустите левую кнопку мыши). 

Полупрозрачным красным цветом закрасится та область, которая будет 

выделена.  

6. Перейдите в стандартный режим, щелкнув по кнопке Edit in Standard Mode 

(Редактирование в стандартном режиме) (Рис. 7). 

 
Рис. 7. Кнопка для перехода в стандартный режим. 

 

7. В стандартном режиме вы увидите выделенную пунктиром область, 

нажмите клавишу Delete, чтобы удалить выделенную часть фотографии. 

Снимите выделение, нажав клавиши Ctrl+D (или через меню Select → Deselect). 

 

Задание 4. Выделение сложного контура (векторный инструмент Pen в 

режиме Paths)  

Пример использования этого эффекта можно посмотреть вps_Контрольная-

1\Вариант-2\_Вариант-2.jpg 

1. В новом рисунке создайте новый слой, залейте его нужным цветом. 



2. Возьмите инструмент рисования векторных фигур Pen (Перо) в режиме 

Paths (Создание контура). Включите режим Add to path area (Добавление к 

области контура) (Рис. 8). 

 
Рис. 8. Настройки инструмента Pen (Перо) для создания контура выделения. 

 

3. Нарисуйте нужный векторный контур вокруг объекта, который должен быть 

выделен. Принцип рисования: нажмите левую кнопку мыши, немного потяните 

мышь в сторону, отпустите левую кнопку, установите курсор мыши в 

следующую точку контура, снова нажмите левую кнопку мыши, потяните мышь 

в сторону, отпустите левую кнопку мыши. Обязательно замкните контур, для 

этого вернитесь в первой точке.  

4. Готовый контур можно отредактировать инструментом Direct Selection 

(Частичное выделение) (Рис. 9). 

 
Рис. 9. Инструмент редактирования векторного контура. 

 

5. Перейдите на палитру Paths (Контуры) и нажмите кнопку Load path as a 

selection (Загрузить путь как выделение) (Рис. 10). Ваш контур превратится в 

выделение, обозначенное пунктирной линией. Нажмите клавишу Delete, чтобы 

удалить выделенную область слоя. После этого снимите выделение, нажав 

Ctrl+D или через меню Select → Deselect. 

 
Рис. 10. Кнопка преобразования векторного контура в область выделения. 



 

Задание 5. Использование эффектов (стилей) слоя. 

Готовую работу можно посмотреть в ps_Практика-2\ metall.jpg 

1. Без эффектов - это просто цветные полоски, которые нарисованы с 

помощью полосатого градиента. Залейте фоновый слой (Background) темно-

синим цветом. Создайте новый слой. Выберите новый цвет для инструментов 

рисования (голубой, лиловый или другой тусклый подходящий к металлическим 

поверхностям). Выберите инструмент Gradient (градиент). На панели свойств 

этого инструмента откройте список градиентов и выберите последний в списке – 

в виде полосок на прозрачном фоне. Проведите несколько полос на слое.   

2. После того, как вы нарисовали несколько полос разного цвета и 

направления, откройте список эффектов (стилей) слоя и установите следующие 

параметры для падающей тени: Drop Shadow (Падающая тень): Size (Размер)= 

10, Contour (Контур) = Half Round (Полукруг) просто чтобы тень была 

размазанная 

3. Основной эффект заключается в применении эффекта Bevel and Emboss 

(Скос и рельеф): Style (Стиль) = Inner Bevel (Внутренний скос), Size (Размер) = 

13, главное в Gloss Countour = Ring Double (Двойной круг). И чтобы дать 

металлический блеск добавляем свойство Contour (Контур), который находится 

на панели эффектов ниже Bevel and Emboss (Скос и рельеф), например, Half 

Round . 

4. Последний штрих дает нам Satin (Атлас) - этот эффект позволяет наложить 

тень с бликами на объект, что смотрится очень реально, обратите внимание Satin 

хорош только для металлических поверхностей. Установите, например, цвет 

синий, Opacity (Непрозрачность) = 50%, Distance (Расстояние) = 11, Size 

(Размер) = 14, и Contour (Контур) = Half Round.  

5. После этого можно добавить дополнительный штрих. Под слоем с 

полосками создать новый слой, применить к нему градиентную заливку (сине-

голубое кольцо), а также  эффект Pattern Overley (Наложение узора), из списка 

узоров можно выбрать узор елочкой. Работа готова.  
 

 

 

  



 Тоновая и цветовая коррекция фотографий 

 

Задание 1. Использование инструмента Shadow/Highlight. 

Откройте исходное изображение из папки ps_Практика-3\Варакушка.jpg. То, 

что это птичка, нам понятно, но о ее красоте судить достаточно трудно, 

поскольку тени сильно «провалены» из-за сложных условий съемки. К 

сожалению, при съемке в дикой природе, иногда просто нет возможности 

подойти к объекту с нужной стороны, а кадр упускать жалко… Попробуем 

исправить эту фотографию.  

1. Создайте копию основного изображения, нажав Ctrl+J.  

2. Включите показ гистограммы: Window → Histogram (Окно→Гистограмма). 

3. Откройте панель инструмента Shadow/Highlight: Image → Adjustments → 

Shadow/Highlight. Полностью раскройте всю панель этого инструмента, 

установив галочку Show More Options (Показать расширенные опции). На 

гистограмме бледными участками отображается предыдущее значение, а 

темными текущее. Хорошо заметно, что количество средних тонов 

увеличилось.Передвиньте ползунки так, чтобы на ваш вкус фотография 

смотрелась хорошо. Учитывайте, что нет строгих правил коррекции, только 

индивидуальный подход. 

4. Добившись удовлетворительного результата, сохраните изображение под 

новым именем. Не рекомендуется сохранять результат коррекции в файле 

источника, может быть вы захотите в другой раз откорректировать изображение 

по новому. 

 

Задание 2. Проведите цветокоррекцию фотографии с использованием 

корректирующих слоев. 

Коррекцию изображения (яркость, контраст, насыщенность и прочие 

регулировки) можно проводить непосредственно на исходном материале, что 

очень многие фотолюбители и делают. Но, если не использовать при этом 

корректирующие слои, возникают следующие проблемы:  

1. В процессе работы вы не можете вернуться к предыдущим корректировкам 

и внести какие-либо поправки в сделанные вами изменения (а это нужно 

практически всегда, особенно если это большая и сложная работа).  

2. Даже если вам удастся вернуться к этому шагу (у вас очень много 

оперативной памяти компьютера, и палитра истории настроена на большое 

количество шагов), то вы тем самым отмените все последующие, сделанные 

вами с таким трудом изменения.  



3. Вы не можете изменить в широком спектре силу воздействия сделанных 

вами настроек применения любых фильтров. Применение корректирующих 

слоев избавляет вас от всего вышесказанного и превращает работу в 

удовольствие. Поэтому примите для себя первейшее правило — исходное 

изображение должно остаться нетронутым до самого последнего момента!  

1. Откройте исходное изображение из папки ps_Практика-3\Чекан.jpg. В 

панели Histogram (Гистограмма), откройте список всех настроек и поставьте 

флажки напротив All Channels View (Показывать все каналы) и Show Channels 

in Color (Показывать каналы в цвете). 

2. Вызвать меню корректирующих слоев можно двумя путями. Layer→New 

Adjustment Layer→ нужный слой (Слой → Новый корректирующий слой → 

…) или, что проще, пиктограммой Create New fill or Adjustment Layer (Создать 

новый заливочный или корректирующий слой) на палитре Layers (Слои) (Рис. 

1). 

 
Рис.1. Пиктограмма Create New fill or Adjustment Layer (Создать новый 

заливочный или корректирующий слой) на палитре Layers 

3. Уровни.  Включите корректирующий слой Levels (Уровни): Layer→New 

Adjustment Layer→ Levels→ ОК (Слой → Новый корректирующий слой → 

Уровни). У снимка очень узкий динамический диапазон, что хорошо видно из 

гистограммы инструмента Levels (Уровни). Давайте расширим диапазон для 

того, чтобы придать нашему снимку большую сочность. Для этого нажмите на 

кнопку Auto. Получился «неожиданный» результат - фотография приобрела 

фиолетовый оттенок. Что же произошло? В панели Histogram видно, что синий 

цвет существенно сдвинут относительно красного и зеленого, поэтому при 

расширении динамического диапазона программа будет пытаться их выровнять, 

что и приведет к таким последствиям. Это не означает, что нельзя вообще 

пользоваться автокоррекцией. На хорошо сбалансированных кадрах она часто 

дает отличный результат. Поэтому лучше всего в сложных случаях применять 

ручную корректировку. Для этого передвиньте движки черного и белого уровней 

к началу основной гистограммы.  

4. Выборочная коррекция цвета. Включите корректирующий слой Selective 

Color (Выборочный цвет). В этом слое можно выборочно корректировать 

составляющие основных цветов и цветовые составляющие нейтральных 

оттенков (черного, серого и белого). Конечно, сила воздействия на тот или иной 

цвет зависит от вас и ваших задач. Если может показаться, что насыщенность 



картины слишком высока, то можно применить корректирующий слой 

Hue/Saturation (Цветовой сдвиг/насыщенность). 

5. Возвращение к первоначальному состоянию. На увеличенном фрагменте 

хорошо видно, что на области горла получился пересвет, давайте его 

восстановим в виде, близком к первоначальному. Для этого выберем слой с 

уровнями, включите инструмент Brush (Кисть) клавишей B, размер кисти 

регулируется клавишами [ и ], а жесткость (размытие границ) клавишами Shif+[ 

или Shift+]. Прозрачность кисти установите 30 процентов, просто нажав 

клавишу 3 на клавиатуре, а рисующий цвет — черный. Легкими движениями 

кисти восстановим этот фрагмент до нужного состояния. Каждый проход кисти 

по одному месту будет возвращать 30 процентов первоначального состояния. 

6. Очищение палитры History. После выполнения всех операций,палитра 

истории и оперативная память достаточно сильно заполнились, и ее надо 

почистить. Перед этим желательно сделать операцию Snapshot (Слепок 

состояния), для этого в палитре истории на последней операции нажмите правую 

кнопку мыши и во всплывающем меню выберите New Snapshot (Новый слепок 

состояния). После создания слепка состояния можно правой клавишей мыши 

выбрать Clear History (Очистить историю). А можно более радикально и 

правильно полностью очистить оперативную память Edit→Purge→All 

(Редактирование → Очищение→ Все).  

7. Фильтры резкости. Теперь нужно добавить снимку четкости. Поскольку 

усиление четкости нельзя применить к корректирующим слоям, а с основным 

изображением, как уже говорили, не стоит работать, то необходимо создать 

копию исходного изображения. Сделать это можно разными путями. Например, 

выбрать в палитре Layers (Слои) исходный рисунок — это всегда нижний слой 

Background (Фон), после чего нажать Ctrl+J или стащить мышкой этот слой к 

пиктограмме Create New Layer (Создать новый слой). 

Появилась копия основного изображения под названием Background copy, с 

ним и будем работать. В Photoshop’е есть специальный инструмент для усиления 

резкости — Unsharp Mask (Нерезкая маска). Находится он в меню 

Filter→Sharpen→Unsharp Mask (Фильтр →Резкость →Нерезкая маска). 

Данный фильтр имеет три движка регулировки. 

Amount (Сила воздействия) — устанавливается в диапазоне от 0 до 500 

процентов. Установите в районе 40 процентов.  

Radius (Радиус) — устанавливается в диапазоне от 0,1 до 250 пикселов. Это 

радиус воздействия вашего фильтра. Как правило, не стоит устанавливать его 

значение более 5 (обычно 1-3).  



Threshold (Порог) — очень важный параметр, устанавливающий яркостной 

порог воздействия фильтра. Эффект будет применен ко всем смежным пикселам, 

имеющим порог отличия по яркости более или равный установленному. Чем 

меньше это число, тем больше элементов изображения попадет в область 

воздействия фильтра. Как правило, устанавливается в диапазоне 1—10.  

Недостаток от работы фильтра резкости очень заметен на контурах объекта по 

отношению к фону. Для устранения этого эффекта возьмите ластик (клавиша E) 

и сотрите контур на изображении в тех местах, где это наиболее бросается в 

глаза (нижняя часть клюва и темный контур на белом горлышке). Таким же 

образом нужно пройтись внимательно по всему изображению, при 

необходимости меняя прозрачность ластика в конкретных местах. 

Есть другой метод добавления резкости, с использованием фильтра High Pass 

(Высокая частота). Отключите видимость предыдущего слоя с эффектом 

резкости, создайте новую копию фонового слоя и включите этот фильтр: 

Filter→Other→High Pass (Фильтр → Другие →Высокая частота). Установите 

параметр Radius в диапазоне 1,5—2,5. После этого нужно изменить режим 

смешения этого слоя с Normal на Soft Light. 

При этом силу воздействия фильтра можно плавно менять движком Opacity 

(Непрозрачность). Если вам захочется еще усилить его воздействие, то смените 

режим смешения с Soft Light на Hard Light.  

8. Фильтр размытия. Еще один важный и часто применяемый фильтр - это 

Blur (Размытие). Разновидностей этого фильтра несколько. Например, 

применение Gaussian Blur (Размытие по Гауссу) дает очень хороший эффект, 

когда надо сгладить элементы фона. Им можно маскировать «шум» на 

изображении, придавать мягкость и загадочность картинке и многое другое. 

Создайте копию основного изображения и включите фильтр размытия 

Filter→Blur→Gaussian Blur (Фильтр →Размытие → Размытие по Гауссу). 

Установите значение радиуса размытия на 3 пиксела. Вообще, в данном 

фильтре этот параметр может устанавливаться в очень широких пределах, в 

зависимости от требуемой задачи. Как видно, фон приобрел более ровный и 

красивый вид, но и птичка также. Возьмите ластик и мягко стирайте птичку. 

Жесткость ластика (размытые границы) сделайте минимальной. В центре птички 

можно установить размер ластика побольше и непрозрачность 100 процентов, а 

по мере приближения к краям размер и прозрачность уменьшайте. Не нужно 

точно повторять контуры объекта, желательно слегка захватить и область фона 

на границе перехода, тогда картина будет более естественной.  

7. Сохраните полученное изображение в своей рабочей папке. 



 Использование векторных контуров 

 

Задание 1. Создайте рисунок «НЛО» используя векторные контуры. 

Готовую работу можно посмотреть в папке ps_Практика-4\НЛО.jpg. 

1. Откройте рисунок из папки ps_Практика-1\Поворот\Лужники.jpg. 

2.Поворот изображения. Image (Изображение) → Rotate Canvas (Поворот 

холста) → Arbitrary (Произвольно). Поставьте переключатель CW (По часовой 

стрелке), в поле Angle (Угол) напишите 28,5 нажмите ОК. 

3.Обрезка изображения. Инструментом Zoom (Лупа) Уменьшите масштаб 

изображения так, чтобы оно полностью уместилось на экране. Возьмите 

инструмент Crop (Обрезка)      и нарисуйте рамку выделения на фотографии 

так, чтобы получился узкий прямоугольник.  

4. Восстановление частей изображения. После обрезки, в углах фотографии 

могут остаться белые прямоугольники.  

Возьмите инструмент Smudge  и размажьте небо в углу фотографии. 

Возьмите инструмент Clone Stamp  , нажмите клавишу Alt, щелкните в 

области темного леса, отпустите клавишу Alt и закрасьте левый нижний угол 

фотографии (как обычной кисточкой). Посмотрите, вы клонируете часть 

изображения на новое место! таким образом можно сделать мираж университета 

в небе, только не забудьте установить на панели свойств (вверху) Opacity 

(Непрозрачность) = 100%. 

5.Улучшение контрастности и яркости изображения. Меню Image 

(Рисунок) – Adjust (Настройка) – Auto Levels (Авто уровни). 

6.Установка градиентной карты цветов. На панели инструментов 

установите следующие рабочие цвета: верхний (set foreground color) – светло-

голубой, нижний (set background color)  – темно-синий. Выполните команду 

Image (Рисунок) – Gradient Map (Градиентная карта) в диалоговом окне это 

команды установите флажок Reverse (Обратить), нажмите ОК.  

7.Рисование контуров. На панели инструментов выберите инструмент Ellipse 

(Эллипс), на панели свойств инструмента нажмите кнопки Shape layers 

(Контурный слой) 

 
и Add to shape area (Добавление в контурную область).  



 
Нарисуйте эллипс и под ним маленький круг. Нарисуйте над большим 

эллипсом прямоугольник, используя команду Rectangle (Прямоугольник). 

8.Выделение контуров. Выберите инструмент Path Selection (Выделение 

пути) и щелкните по прямоугольнику. Контур выделен. Его узлы приняли вид 

заполненных квадратиков.  

 
Чтобы снять выделение, щелкните на свободно от контуров области рисунка. 

Перемещение контуров: укажите стрелкой внутрь контура и тащите контур 

левой кнопкой мыши. Удаление контуров: если контур выделен, нажмите 

клавишу Delete. 

9. Нарисуйте НЛО в виде тарелки. Выберите инструмент Direct Selection 

(Прямое выделение)  , он находится в той же группе инструментов, что и Path 

Selection.  

Создайте форму летающей тарелки, для этого: 

- перемещайте узлы (квадратики), управляющие линии, выходящие из узлов, 

сегменты (части контура между узлами); 

- используйте свободную трансформацию: Ctrl+T (в конце действия 

нажимайте Enter); 

- копируйте контуры сочетаниями клавиш Ctrl+C и Ctrl+V; 

- зеркальное отображение Edit – Transform – Flip Horizontal или Flip 

Vertical; 

- комбинируйте контуры для создания дырок: выделите контуры-круги и 

нажмите на панели свойств кнопку Combine (Комбинировать). 

 

 
 

10.Размножьте тарелки. Скопируйте слой с готовой летающей тарелкой два 

раза. На каждом слое уменьшите и поверните тарелки, чтобы получился эффект 

летящих друг за другом тарелок. 



11.Задайте эффекты для тарелок. Задайте слою темно-синий цвет и 

эффекты. Например. Bevel and Emboss (Скос и рельеф) со внутренним скосом 

Inner Bevel, Outer Glow (Внешнее свечение) с градиентом от голубого к 

зеленоватому и растущей прозрачностью, Stroke (Обводка) по внешнему краю 

Outside в режиме Multiply (Умножение) с градиентом от черного к белому, а 

также Satin (Шелк). Полупрозрачной кистью в режиме наложения Mode = 

Screen (Осветление) сделайте лучи прожекторов. Сохраните стиль оформления 

летающей тарелки в списке стилей и примените для двух других тарелок. 

12.Затемните небо. Выше всех слоев создайте новый слой и сделайте на нем 

градиентную заливку от темно-синего цвета к прозрачному и проведите сверху 

вниз, чтобы затемнить небо. Также можно слои с тарелками сделать слегка 

прозрачными. 

13. Инопланетянин. Используя инструмент Freeform Pen (Свободное перо) 

, нарисуйте маску инопланетянина. Можно задать этому контуру следующие 

эффекты: Satin (Шелк), режим наложения слоя Overlay (Перекрытие), 

непрозрачность – 50%, цвет светло-голубой, а также Bevel and Emboss (Скос и 

рельеф) со внутренним скосом Inner Bevel, размером 35 пикселов. 

14. Сохраните рисунок на своем диске под именем НЛО. 



 


